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1 Introduction 

Application Management Profiles 

The Radia Application Management Profiles includes a set of tools built on 
top of Application Manager to enable the deployment and management of 
complex software products that are typically required to be present on 
servers in a datacenter environment such as Microsoft SQL Server, Oracle, 
Apache, and Internet Information Server among others. These products often 
employ their own instrumentation or repositories for deployment and 
management of their implementation. 

Application Management Profiles provides tools to: 

• Analyze and parameterize configuration control data for targeted 
products  

• Specify values in the form of a model to be used at deployment time 

• Articulate in the model pre-requisites and constraints that qualify the 
ability to deploy the products 

• Publish the control information and required ancillary tools such as 
utility programs to the HP OpenView Using Radia infrastructure for 
deployment 

• Deploy and configure the software to targeted devices 

• Interact with the target environment before and after installation to 
enhance management of the deployment 

• Report on the success of the deployment 

The intent of this book is to provide instruction on how to deploy server 
applications using these tools.  The figure below provides a general workflow. 

 
To use the Application Management Profiles Client Agent, you 
must own a Server LTU for Application Manager using Radia.   
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Figure 1: Workflow. 

 

Terminology 

The following terms are used in this Guide and are specific to Application 
Management Profiles: 

Master Application Profile (MAP)  

An XML-based specification of a Server application’s installation parameters.  
A parameter in the XML might refer to the installation directory of an 
application. 

Custom Application Profile (CAP) 

A MAP that has been customized to your environment. 
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Utility Class 

A class in the Configuration Server Database specifically used for a 
particular server application.  For example, the Utility class used for 
Microsoft SQL Server 2000 is called MSSQL2K. 

Audience 

This guide is for administrators of Application Management Profiles. You will 
learn how to use the tools supplied to deploy server applications. 

Prerequisites 

The reader should be familiar with the following products: 

HP OpenView Configuration Server Using Radia  

HP OpenView Administrator Workstation Using Radia 

HP OpenView Application Manager Using Radia 

HP OpenView Management Portal Using Radia 

 
To use the Application Management Profiles Client Agent, you 
must own a Server LTU for Application Manager using Radia.   

Additional Components 

In addition to already established Radia products, Application Management 
Profiles use: 

• New Configuration Server Database Domain and classes  

• Master application profiles for supported applications  

• A set of client methods specific to deploy Server Applications 

• The Application Management Profiles Editor to administer the profiles 
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Chapters Summary 

In addition to this chapter, this book contains the following information 

• Installing Application Management Profiles 

• Packaging Server Applications 

• Preparing Server Applications 

• Appendices on the applications supported at the time of publishing 

Related Documents 

HP OpenView Configuration Server Using Radia Guide 

HP OpenView Administrator Workstations Using Radia Guide 

HP OpenView Management Portal Using Radia Guide 

HP OpenView Application Manager Using Radia Guide
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2 Installing Application Management 
Profiles 

• This chapter includes instructions on how to install the components 
needed to use Application Management Profiles. 
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Installation Media 

The Application Management Profiles media contains the following 
directories 

• Application Management Profiles Editor contains the installation 
materials for the Application Management Profiles editor. 

• Management Application Profiles contains one subdirectory for each 
provided profile.  Each subdirectory includes the profile, a descriptive 
html document, export decks for the Configuration Server Database, and 
a command file to import each deck. 

• Radia Configuration Server Database contains the export deck for the 
APPMGMT Domain and a command file to import the deck. 

 
To use the Application Management Profiles Client Agent, you 
must own a Server LTU for Application Manager using Radia.   

Prerequisites 

Before installing the components on the Application Management Profiles 
media, you will need to complete the following tasks: 

• Designate a Configuration Server to host your profiles and policy 
information. 

• Install System Explorer and Packager on a computer designated for 
administration. 

• Install Application Manager 4.0.1 on your target servers. 

• Install Radia Reporting Server Version 4.1.1 or above. 

 
All components of the HP OpenView Using Radia 
Infrastructure must be at a minimum version 4.1 unless 
otherwise noted. 

Installation Process 

After meeting the prerequisites, you will need to do the following: 

• Modify the Configuration Server Database 
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• Install the Application Management Profiles Editor 

To modify the Configuration Server Database 

1 Copy the files from the Radia Configuration Server Database directory to 
the Configuration Server’s bin directory. 

2 Use System Explorer to create a new domain called APPMGMT. 

3 Stop the Configuration Server. 

4 Import the new classes into the APPMGMT domain by running the 
following commands from the Radia Configuration Server’s bin directory: 

import_appmgmt.cmd on Windows systems 

import_appmgmt.sh on UNIX systems 

Copy the xpc and cmd  or sh files from the appropriate subdirectory of the 
Management Application Profiles directory.  You must import any classes 
for the applications you will be deploying.   

Run the appropriate import.cmd  in import.sh file from the Radia 
Configuration Server’s bin directory 

Repeat this step for each server application. 

5 Restart the Configuration Server. 

6 Use System Explorer to see the new domain’s classes. 
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Figure 2: View the APPMGMT domain. 

 

Installing the Application Management Profiles Editor 

The Application Management Profiles Editor allows you to modify the 
profiles provided.  You will probably want to install the Application 
Management Profiles Editor on the same computer as the System Explorer 
and Packager. 

 
At the time of the writing, the Application Management Profiles 
Editor is only available for Windows operating systems. 
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To install the Application Management Profiles Editor  

1 From the Application Management Profiles Editor subdirectory, on the 
installation media, double-click setup.exe. 

 

 

2 Click Next. 
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7 Click I accept the terms of the license agreement. 

8 Click Next. 
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9 Click Next to accept the directory path. 

 

 

10 Click Install. 

11 Click Finish. 

The Application Management Profiles Editor is installed. 

To start the Application Management Profiles Editor 

• From the Start Menu, select the Radia Administrator Workstation group.  
Click the icon for Application Management Profiles Editor. 
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3 Packaging Server Applications 
This chapter describes how to package the installation media, how to use the 
Application Management Profile Editor to create your custom application 
profiles (CAP), and how to publish the CAP to the Configuration Server 
Database. 
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Packaging Server Applications 

To package the Server application, you must perform the following tasks: 

1 Package the installation media. 

2 Modify the profile to create your Custom Application Profile (CAP). 

3 Package the CAP. 

 
Figure 3: Package the Server Application 
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Packaging the Installation Media 

You can use the Packager to create an installation point or access the media 
from a network share. Packager’s component selection mode may be the 
simplest approach to use. 

To Package the Installation Media using Component Selection Mode 

Use Packager’s component selection mode to promote the server application’s 
installation media.   For complete information on Packager, see the HP 
OpenView Application Manager using Radia Guide. 

 
Be sure that your Configuration Server has adequate space for the 
installation media. 

• Copy the installation media to a directory path where the software will be 
installed from on the client computer.  If you do not package from this 
directory, you will need to change the Path instance in the Configuration 
Server Database. 

• Give the package a meaningful name. 

• Promote the package to the APPMGMT Domain, not the SOFTWARE 
Domain. 
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Figure 4: Promote the installation media to the APPMGMT Domain. 
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Application Management Profile Editor  

This tool allows you to make an Application Management Profile available to 
the system for deployment. This interface allows you to: 

• Construct or modify a profile for use with a specific software package 

• Open a profile for customization from local file system 

• Create configuration settings 

• Add commands to be run before, during, and after an installation 

Master Application Profiles (MAP) will be provided for each supported 
application. These will serve as examples that you can use to create your own 
company specific deployments called Customer Application Profiles (CAP). 

 
At the time of this writing, the Application Management Profiles 
Editor is available only on Windows operating systems. 
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Creating a Custom Application Profile 

Use the Application Profiles Editor to create your own Custom Application 
Profiles from the examples provided by HP.  The Application Profiles Editor 
should be installed on an administrator computer with access to these files.  
The Application Profiles Editor is organized into tabs.  Tabs may vary from 
one application to another.  All of the files have a Configuration and File 
Templates tab.  Depending on the server application, you may also have an 
Initialize, Pre-Install, Install, and Post-Install tab.   

Phases 

From the File menu of the Application Profiles Editor, open a profile. 

 
Figure 5: Phases of Microsoft SQL Server Sample file. 

 

Each profile may or may not have the following tabs included.   

• Configuration 
Use the configuration tab to edit installation parameters.  These values 
can be referred to in commands that you create.   

• File Templates 
Shows the files that the profile will modify on the target computer.   

• Initialize 
During the Intialize phase, the Application Management Profile Client 
gets information that will be used during the Install Phase. 
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• Pre-Install 
Specify any commands that you want to run before the installation such 
as turning off anti-virus software or checking for disk space. 

• Install 
Specify the commands to run the installation such as executing the setup 
file or checking if a computer restart is needed. 

• Post-Install 
Specify any commands that you want to run after the installation such as 
turning on anti-virus software or restarting a service. 

Configuration Settings 

Create sections of Configuration Settings to construction your Application 
Management Profiles.  For each section, create instances with the necessary 
parameters.  HP provides a set of sample profiles that you may use to see 
examples of configuration settings. 

To add a section to Configuration Settings 

1 From the Configuration tab, click Add underneath the sections box. 

 

 

2 Click New section. 
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4 Type a Section name, Display title, Description, and Minimum and Maximum 
number of occurrences.  In this example, we are creating a section for the 
License Key. 

5 Click Save. 
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The new section is created.  You will need to add parameters to the section. 

To add a parameter to a section 

1 From the Section, click Add parameter. 
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2 Type in a Parameter name, Display title, Description, Default value (if 
needed), and Length. 

3 Click Save. 
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The parameter is created.  Repeat this procedure for each parameter you 
need to create in this section.  When you have finished, you can add instances 
of the section. 

To add an instance of a section 

1 From the Configuration tab, click Add underneath the sections box. 

2 Click New Instance. 
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3 Select a section to add an instance, and type an Instance name.  In this 
example, we are adding a User credentials instance. 

4 Click Done. 

5 Click the new instance name under its Section in the Section list box. 

6 Type in the required parameters. 

7 Click Next to complete the creation of the new instance. 

The new instance is created.  You are now able to refer to this instance in 
your Commands. 

 
If there is only one instance of a section, that instance will 
automatically display when you click on the section name.  If there 
are multiple instances, the instance names will be nested under 
the Section name. 
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File Templates 

The Application Management Profiles Editor allows you to add and delete 
lines in File Templates, as well as add If statements.   

 

 
Figure 6: View the File Templates tab 

 

• Click Add line to add a line to the file template. 

• Click Remove line to remove a line from the file template. 

• Click Move Up to move a line up in the file template. 

• Click Move Down to move a line down in the file template. 

• Click Add If block to add an If statement.  You will need to include a 
condition, a value if the condition is true, and a value if the condition is 
false.  If the false value is not needed, simply highlight the line with the 
<ELSE> and click Remove line.  The whole else clause will be removed. 
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Adding Commands 

Create commands to further control your installation. Add a command by 
clicking on Add in the Initialize, Pre-Install, Install or Post-Install phase. 

 

 
Figure 7: Select a command. 

 

For each command, specify a Command title and a Command description.  
Each command has its own set of parameters that you will need to specify. 

You can choose from the following commands, 
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Table 1: Commands and Descriptions 

Command Type Description 

Check Registry Use this to check for the existence of a given 
registry entry. Returns a value >0 if found. 
Returns 0 if no entry is found. 

Get Registry Value Use this to get the registry value for a 
specify key if there is a value.  If not, returns 
an empty string.  To check for the existence 
of a registry key, leave the value blank. 

Get Disk Space Get the amount of disk space on the target 
computer.  You have the option of finding 
either total capacity or free disk space. 

Windows Service Query Use this to find if a Windows Service exists 
or to find if the Service is stopped, started, or 
disabled. 

External Select this to run an external command.  You 
will be required to include all necessary 
information to run the external command. 

Change State of Windows 
Service 

Use this to change the state of a Windows 
Service.  For example, you may need to stop 
a Windows Server to install the application, 
or need to restart a service after installation. 

Network Share Use this to connect or disconnect from a 
network share.  If the installation media is 
located on your network, you will need to 
specify a network location and credentials 
before starting the installation. 

Reboot device Use this to Restart, Power Off, Logoff or 
Shutdown the target computer. 

File Operations Use this to normalize file names, use the 
appropriate characters for your operating 
system (native), or to delete a file. 

Create File Select a file to create during the phase. 

Set Parameter Use this to set a parameter’s value for an 
instance from the Configuration tab. 

Set Registry Value Set a value in the Registry using this 
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Command Type Description 

command. 

Get an attribute value from 
a client object 

Use this to get the value of an attribute from 
a Radia Object.  You will need to specify the 
directory location of the object. 

Set an attribute in a client 
object 

Use this to set the value of an attribute of a 
Radia Object.  You will need to specify the 
directory location of the object. 

Sleep for seconds and 
milliseconds specified 

Specify a period of time for the process to 
sleep.  Use this to create a pause between 
command processing to allow for command 
clean up. 

Read File Data Use this command to read data from a file on 
the target device and assign the data to the 
command output. The output can then be 
used by other commands. 

 

Pre-Conditions and Post-Conditions 

For each command, you can specify a pre-condition and a post-condition. If 
the pre-condition fails, the command will not run; the command will be 
skipped, and we will go to the next command in the chain. If the post-
condition fails, the installation will stop. Be sure to specify what type of 
message you want returned or displayed.   

Building a String 

Some of the parameters for a command may require building an argument 
string.  To do this, use the String Builder.    To start using the string builder, 
click on the ellipsis at the end of a parameter.  Depending on the parameter, 
the following operands may be available in the String builder. 

 

Table 2: Available Operands in the String Builder 

Operand Description 

Space Use to add a space to the string. 
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Operand Description 

Environment 
Reference 

Use to create an Environment Reference. 

Command 
Output 
Reference 

Use to refer to the output of another command from any 
phase of the application profile. 

Command 
Return 
Reference 

Use to refer to the return code of another command 
from any phase of the application profile. 

File Content 
Reference 

Use to refer to an entry in the File templates section. 

Credential 
Reference 

Use this when you need a set of credentials, such as 
connecting to a network share. 

Number Use this to type in a numeric value. 

Parameter 
Reference 

Use to reference a parameter from the Configuration 
tab. 

Client Object 
Reference 

Use to reference a Client Object. 

String Use this to type in a string of text. 

If block Use this when you will need to branch the expression.  
You will need to provide a condition, a value if the 
condition is true, and a value if the condition is false.  
Note that you can create nested If statements. 

 

Command Modes 

Some commands only need to be executed when the Client is running in a 
specific mode.  The possible modes are create, delete, verify, update, and 
repair. These modes together form life cycle management of an application 

This mode is available for the Application Management Profiles client agent 
to use. The mode can be used to control when commands and phases are 
performed. By default, the mode is blank; this means that the command or 
phase would be executed in all the life cycle management modes of the Client. 
If a phase or command has a specific mode defined, the mode would be 
compared with the current life cycle management mode. If the life cycle 
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management mode matches the command or phase mode, then the command 
or phase would be executed.  Otherwise, the command or phase would be 
skipped.  For example, if the command or phase should be executed only 
when the Client is doing a create or a verify, then you would select the create 
and verify modes in the Modes for this command section. If the life cycle 
management mode does not match the phase or command mode, then the 
phase or command would be skipped. 

Command Examples 

The sections below detail some of the commands and how to use the String 
Builder by example. 

Get Registry Value 

In the procedure below, you will check a fetch a registry value to get the 
installation path for Microsoft Windows.   

To get a registry value 

1 In the Add Command dialog box, click Get Registry Value. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the Key field to start the String Builder.  
This is the key you will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are fetching the value from. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder.  This is the registry value you will be getting. 
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10 Click Update, and then Save. 

11 The results of your new command will be displayed. 
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Get Disk Space 

In the procedure below, you will check a drive to see if it has adequate space 
for installation.  The drive will be specified by creating a parameter reference 
to a directory path.  The drive where the directory resides will be checked. 

To get disk space information 

1 In the Add Command dialog box, click Get Disk Space. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the Drive Letter field to start the String 
Builder.  This is the drive or path on the drive you will be checking. 

5 Click Edit. 

6 Click Parameter Reference. 
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7 Click Update, then click Save. 

8 From the Type drop-down, click Free. 

9 The results of your new command will be displayed. 
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External 

To use an external command 

1 In the Add Command dialog box, click External. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the Command field to start the String 
Builder.  This is the external command you want to run. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 
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7 Click Update, and then Save. 

8 Click on the ellipsis at the end of the Arguments field to start the String 
Builder.  Set all arguments for the external command here. 

9 Click Update, and then Save. 

10 Check if you want to wait for the command to end. 

11 If needed, select a Working Directory, Output File, and user credentials. 

12 Click Update, and then Save in the String Builder after you have edited 
all needed fields. 

13 The results of your new command will be displayed. 
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Change State of Windows Service 

In the procedure below, you will check a drive to start the Apache Service 
after installation.  The Service to start will be specified by creating a 
parameter reference. 

To change the state of a Windows Service 

1 In the Add Command dialog box, click Change State of Windows Service. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the Service name field to start the 
String Builder.  This is the service you will be changing the state of. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down, click the section you want to get the parameter 
from.  In this case, we select the Service Name from Product 
Configuration Options. 
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8 Click Update, and then click Save. 

9 From the Action drop-down, click Start. 
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Network Share 

In the procedure below, we need to connect to a network share.  Credentials 
must be supplied. 

 

To specify information for a network share 

1 In the Add Command dialog box, click Network Share. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the Share Name field to start the String 
Builder.  This is the parameter you will be setting the value for. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down, click the section you want to get the share name 
from.  

8 Click Update, and then Save. 

9 From the Action drop-down, click Connect or Disconnect.  In this case, we 
want to connect. 

10 Click on the ellipsis at the end of the Credentials field to start the String 
Builder.  These are the set of credentials you will use to connect to the 
network share. 
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11 Click Edit. 

 

 

12 Click Update, and then Save. 

13 The results of your new command will be displayed. 
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Reboot device 

In this example, we will restart the target computer.  Note that this contains 
a pre-condition to see if a reboot is needed. 

To reboot a device 

1 In the Add Command dialog box, click Reboot device. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 From the Type drop-down, click the type of reboot you want.  Your 
options are Restart, Power Off, Logoff, and Shutdown. 

5 The results of your new command are displayed. 
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File Operations 

In this example, we want the file name to be put into a native format. 

To perform a file operation 

1 In the Add Command dialog box, click File Operations. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 From the Operation drop-down, select the operation you wish to perform. 

5 Click on the ellipsis at the end of the File name field to start the String 
Builder.  This is the file name you will be performing the operation on. 

6 Click Edit. 

7 From the Operands, click Parameter Reference. 

8 From the drop-down, click the section you want to get the parameter 
from. 
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9 Click Update, and then click Save. 

10 The results of your new command will be displayed. 
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Create File 

In the procedure below, you will create a configuration file.  The file 
information will be retrieved from the File Template. 

To create a file 

1 In the Add Command dialog box, click Create File. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the File name field to start the String 
Builder.  This is the file you will be creating. 

5 Click Edit. 

6 From the Operands, click File Content Reference.  Select the file to create.  
Type a directory and a File name.  Check if you want to delete the file 
after use. 
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7 Click Update, and then Save. 

8 The results of your new command will be displayed. 
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Set Parameter 

In the procedure below, you will set the Media Directory for installation using 
the Set Parameter Command.  The parameter will be retrieved from a Client 
Object. 

To set a parameter from a Client Object 

1 In the Add Command dialog box, click Set Parameter. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the Parameter name field to start the 
String Builder.  This is the parameter you will be setting the value for. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down, click the section you want to get the parameter 
from.  In this case we select Radia Settings, the default instance, and 
Media Directory. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder.  This is the value you will be setting the parameter to. 

10 Click Edit. 
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11 Enter the required information. 

 

 

12 Click Update, and then Save. 

13 The results of your new command will be displayed. 
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Set Registry Value 

To set a registry value 

1 In the Add Command dialog box, click Set Registry Value. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click OK. 
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4 Click on the ellipsis at the end of the Key field to start the String Builder.  
This is the key you will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are going to set. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder.  This is the registry value you will be setting. 

10 Click Edit. 

11 From the Operands, click String. 

12 Type the value you are going to set. 
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13 Click Update, and then Save. 

14 Click on the ellipsis at the end of the Data field to start the String 
Builder.  This is the data you will set the value to. 

15 Click Edit. 

16 From the Operands, click Parameter Reference.  In this case, we are 
setting the Source Directory to the Media Directory. 

 

 

17 Click Update, and then Save. 

18 From the Type drop-down, select the data type. 

19 The results of your new command will be displayed. 
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Header Information 

You may want to create header information to track versions, authors, and 
features of application management profiles.  

To created header information 

1 From the Edit menu, click Edit Header Information. 

2 In the dialog box, type in the values you want. 
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3 Click Save. 

The header information has been added to the application profile’s xml file. 
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Publishing a Profile 

After you have created your CAP, you are now ready to promote it to the 
Radia Database.  

 
Name the file control.xml, to save space on the command line 
when calling ZCREATE.  By default the method looks at 
control.xml in the APPMGMT folder under the current IDMLIB. 

To promote an Application Management Profile  

Use the Packager’s Component Selection Mode to package the CAP file to the 
Configuration Server. 

During your packaging session, be sure to make the following changes from 
the default behaviors: 

• Change the domain to APPMGMT 
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Figure 8: Package the CAP to the APPMGMT Domain 

 

• Enter a meaningful package name, such as SQL2K_CAP_CTRL. 

• Select your CAP, control.xml, for packaging. 

 
By default, the Application Management Profiles Client Agent, 
looks for the CAP file in &(ZMASTER.ZLIBDRV) 
&(ZMASTER.ZLIBDIR)APPMGMT\control.xml.  Set the file 
names to control.xml to conserve space on the command line. 
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• Use the Database Information tab in the file properties to set the class 
name to APPCNTRL. 

 
Figure 9: Set the properties to the APPCNTRL class. 

 

 
You can edit the path of this instance using System Explorer. 
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4 Preparing Server Applications 
After packaging your custom application profile to the Radia Database, you 
are ready to use the System Explorer to perform further modifications. 
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 Prepare the Package 

After creating and packaging the media and control files, you will need to 
some modifications to the instances in the APPMGMT Domain using the 
System Explorer.  To prepare the server application, you will need to perform 
the following tasks. 

1 Create a Utility instance for the Server Application 

2 Create a Service instance in the Configuration Server Database. 

3 Connect the media package and utility instances to the Service. 

 

 
Figure 10: Workflow. 
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Overriding Values in the CAP (Utility Instances) 

Utility Classes in the Configuration Server Database are used to create 
server specific overrides for the CAP.  At the time of this writing, the 
following Utility Classes are available. 

• IIS60 and IIS_WEB for Microsoft Internet Information Server 

• MSSQL2K for Microsoft SQL Server.  This is available for Windows only. 

• APACHE2 and VIRTWEB for Apache Server Version 2. 

• WEBLOGC8 for BEA WebLogic. 

Use the Utility instance for a Server Application to override values in the 
Custom Application Profile.  This allows you to use one profile with small 
variations for each target computer in your enterprise.  Use System Explorer 
to create and modify Utility instances.  To do this, navigate to the relevant 
Utility Class, create an instance, and double-click the appropriate attribute 
to edit it. 

In the example, below we will create a Utility instance to override the SQL 
Instance name.  

To create a Utility instance 

1 Create a new instance of the APPMGMT.MSSQL2K class. 

2 Double click the attribute you want to change.  In this class, we select 
INSTNAME. 

 

 



 

74 Chapter 4 

3 Click OK, and then Save to save the changes. 

You will connect this Utility override instance to the ZSERVICE instance for 
the server application.  If a value exists in the Utility Class, the value is used 
instead of the value in the CAP.  Use _NONE_ to tell the client that this 
variable has no value in the Configuration Server database and the values 
from the CAP should be used.  

Modifying the Path Instance 

Use System Explorer to change attributes of the PATH instance for the 
Custom Application Profile (CAP) package you created to have the values 
shown below. This will ensure that the CAP goes to the APPMGMT folder 
under the current application on the target computer. 

• DRIVE  &(ZMASTER.ZLIBDRV) 

• DIR &(ZMASTER.ZLIBDIR)APPMGMT 

 

 

Creating the Service 

Once you have packaged the installation media and CAP, and created a 
Utility instance, you are ready to create the Service (ZSERVICE) instance for 
the server application. 
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To create the service 

1 Use System Explorer to create a new instance of the ZSERVICE class in 
the APPMGMT domain. 

 
The APPMGMT domain has many of the same classes as the 
SOFTWARE domain. Be sure that you are performing all of 
these edits in the APPMGMT domain. 

2 Connect the Installation Media package to the ZSERVICE. 

3 Connect the Utility class instance to the ZSERVICE using the 
OVERRIDE Class Connection.  For more information on connecting the 
Utility class, see Naming and Connecting the Utility Instance on page 76. 

 
If you do not have a valid Utility instance, the installation will 
fail.  The client methods for executing the installation of the 
server applications are part of the Utility instance. 

4 Connect the CAP Package instance to the ZSERVICE. 
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Naming and Connecting the Utility Instance 

There are multiple methods for connecting the Utility instance.  Decide on 
the method that best suits your needs.  Then, you will need to use the 
appropriate naming convention for the Utility instance. The most common 
methods are described below. 

 
If you do not have a valid Utility instance, the installation will fail.  
The client methods for executing the installation of the server 
applications are part of the Utility instance. 

 

• Multiple computers with identical configurations 

— Use a descriptive name for the Utility instance.  For example, create 
a DEMOWEB instance in the VIRTWEB class. 

— ZSERVICE.OVERRIDE Value:  APPMGMT.VIRTWEB.DEMO_WEB 

 

 

• Each computer with one configuration 

— Create one instance for each target computer in the Utility Class.  
For example, create two instances in the APPMGMT.APACHE2 class.  
One named SRV020, and the other named SRV850.  When the service 
is deployed, SRV020 will use APACHE2.SRV020.  SRV850 will use 
APACHE2.SRV850. The computer name is taken from the ZUSERID 
attribute of the ZMASTER client object. 
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— ZSERVICE.OVERRIDE Value:  
APPMGMT.APACHE2.&(ZMASTER.ZUSERID) 

 

 

• One computer with multiple instances of the same application 

— Use this naming method when an application supports multiple 
instances, such as Microsoft SQLServer or Oracle.  These server 
applications allow for multiple instances of the application on one 
computer. 

— Name the Utility instance using the name of the computer followed 
by a descriptive suffix. For example, create three instances in the 
APPMGMT.MSSQL2K class, SQLSRV_FINANCE, SQLSRV_HR, 
SQLSRV_DEV.  In each of these instances, set the MSSQL2K. 
INSTNAME to a different value, such as FINANCE, HR, and DEV.  
Leave the other attributes at the _NONE_ value so the Application 
Management Profile’s values will be used.  When the service is 
deployed to SQLSRV, Microsoft SQL Server will be deployed with 3 
named instances. 
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— ZSERVICE.OVERRIDE Value:  
APPMGMT.MSSQL2K.&(ZMASTER.ZUSERID)_* 
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5 Managing and Reporting 
This chapter describes management and reporting methods. 
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Management 

The Application Management Profiles Client Agent is part of the Server 
Management Client.  It must be installed on any target computer that you 
want to deploy server applications to.  Install it using the Management Portal 
or using the installation from the CD-ROM.  For detailed installation 
instructions, refer to the Management Portal Guide or the Application 
Manager Guide.  For minimum system requirements, refer to the Application 
Manager Guide for the appropriate operating system. 

 
To use the Application Management Profiles Client Agent, you 
must own a Server LTU for Application Manager using Radia. 

Installing the Server Management Client 

The directions shown below are for installation through the Management 
Portal version 2.0.  These screens and instructions may change in future 
versions.  See the Management Portal Guide for additional information. 

To install the Server Management Client from the Management Portal 

1 Select the option to install the “Remotely Installable Client Modules” 
when you install the Management Portal.  You must use the client install 
4.0.1 or above CD-ROM.  If not, you will need to copy the files to the 
appropriate operating system directory. 

2 Use the Management Portal's Install Client task to begin the installation 
process. 

3 In the Product section of the Management Portal's Client-opts screen, 
select Server Management. 

 

4 Complete the remaining information in the Client-Opts screen. 
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5 Schedule the installation and submit the job. 

 
If the Radia Management Agent is not already installed on 
the client computer, the Agent will be installed as part of the 
Server Management Client installation. 

To install from the CD-ROM for Windows Clients 

Navigate to the appropriate subdirectory for you operating system on the 
Radia v41 applications CD-ROM.  Double-click setup.exe. When prompted, 
select the Radia Server Management feature. 

 

 

To use the install.ini file for Windows Clients 

In the [PROPERTIES} section of the install.ini file, add the following line: 
ADDLOCAL=NVDINSTALLSVR 

After installing the client, you will need to assign the appropriate services to 
the client computers. 



 

82 Chapter 5 

Use standard Application Manager and Software Manager Deployment 
methods for your server applications.  

Reporting 

Application Management Profiles uses the Reporting Server for deployment 
status.  Reporting Server version 4.1.1is the minimum version required.  To 
view the reports, use an internet browser to go to your Reporting Server’s 
address.  Then, click on Server Management Reports to view the list of 
Application Management Reports.  Two reports are provided, Job Status by 
Device and Job Status by Service. 

 
Figure 11: Application Management Profile Reports. 

 

• Job Status by Device 

Use this report to see the status of jobs by device name.  The report 
includes information on status, reboots, and time of the last job’s start 
and end time. 

 

— Click Successful to view the successful jobs for the device. 

— Click Warning to see warnings associated with this device 

— Click Reboot Pending to see the jobs that require a reboot for 
completion. 

— Click Failed to see the list of failed jobs for this device. 

— Click Total Jobs to see the list of all jobs for this device.  From within 
this report, you can drill down further to see detailed information for 
each job including installation parameters used. 
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• Job Status by Service 

Use this report to see the status of jobs by Service name.  The report 
includes service description, information on status, reboots, and time of 
the last job’s start and end time. 

 

— Click Devices to see the list of devices that received this service. 

— Click Successful to view the successful jobs for the service. 

— Click Warning to see warnings associated with this service. 

— Click Reboot Pending to see the services that require a reboot for 
completion. 

— Click Failed to see the list of failed jobs for this service. 

— Click Total Jobs to see the list of all jobs for this service.  From within 
this report, you can drill down further to see detailed information for 
each job. 
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